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INTRODUCTION 
Welcome to BillQuick® from BQE Software!  
 
BillQuick is a time tracking, billing, and business management software. It offers an easy and efficient way to 
reduce the overhead of your business. BillQuick also accurately track professional hours, and increase your 
revenue. BillQuick incorporates flexible and robust features that adjust to fit your business the way you run 
it. The BillQuick Family is continuously updated, implementing your ideas for inspired new features to make 
it more beneficial to your business.  
 
The goal of this BillQuick Getting Started Guide is to help you get started and become comfortable 
interacting with the BillQuick program. It explains the concepts and procedures involved in setting up of 
BillQuick, focusing on its installation, activation, registration, basic and main functionalities such as master 
information and the flow of data throughout the program, time and expense tracking, project management, 
billing and reporting. By the end this guide, you will be able to run and utilize BillQuick effectively and 
efficiently. 
 
Depending upon your business type, BillQuick adjusts its terminology and activity codes to your industry: 
 

Industry-Specific Terminology 
Architects and 
Engineers 

IT and Computer 
Consultants 

Accountants and 
CPAs 

Attorneys and 
Paralegals 

Employee Employee Timekeeper Employee 
Client Customer Client Client 
Project Job Engagement Matter 
Activity Activity Task/Service Activity 
Company Company Company Firm 
Vendor Vendor Consultant Consultant 
Budget Budget Budget Estimate 

 

 BillQuick Getting Started Guide is not a complete training solution. It is a guided tour designed to set 
up and familiarize you with BillQuick. After completing the guide, we recommend that you explore the 
BillQuick Help and the How Do I help items. You can choose self-learning or guided learning. Guided 
learning utilizes role-based and custom training courses. Check out our trainings for more. You can also 
check BillQuick Implementation Path to familiarize yourself with the process of implementing BillQuick. 

 

 

 

 

http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/products/billquick/services/training
http://www.bqe.com/media/PDF/BQ/2017/BillQuick-Implementation-Path.pdf
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 BillQuick Setup Checklist 

 Task Resources and References 

 Decide what BillQuick edition/flavor you want to install Edition Comparison Chart 

Check our system requirements Hardware Requirements 
Software Requirements 

 Download BillQuick setup Downloads 

Log in as an administrator and install BillQuick Read Installation 

Existing Users: 
Install BillQuick 2017 and convert your existing data to the new 
version 

Upgrade to BillQuick 2017 

 

 Start BillQuick Starting Up BillQuick 

Create or open your company file BillQuick Database 

Set up BillQuick company and preferences 

Sync or import your company data 

BillQuick Startup Interview 
BillQuick Initial Setup Checklist 
Data Integration 
Data Conversion Services 

Activate and license BillQuick Product Activation 

License and Registration 

 Set up company and other master profiles Master Information 
Global Settings 
User Preferences 

Sync or import company data and start using BillQuick Time and Billing 
Reports 
BillQuick Help or PDF Help 
Manual 
BillQuick Trainings 
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http://www.bqe.com/media/PDF/BQ/2017/BillQuick-Help-Manual-2017.pdf
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SYSTEM REQUIREMENTS 
For successful installation and implementation of your BillQuick software, be sure your computer systems 
meet or exceed the requirements mentioned below.  

 Mac and Unix Operating Systems require Web Suite. 

Hardware Requirements 

 2.0 GHZ Intel Pentium IV-class processor or faster 

 2 GB RAM or more 

 1 GB or more of free hard disk space, plus 350 MB additional free hard disk space for installation 

 1024 x 768 screen resolution or more 

 Be sure your network server contains sufficient memory and other resources for efficient, high speed 
operation.  

Software Requirements 

Here are the operating system and other software requirements for BillQuick. 

Operating System Requirements 

 Microsoft Windows 10/Windows 8/Windows 7 

 Microsoft Windows Server 2016/2012/2008, Small Business Server 2011 

 Windows Server 2012 Essentials/R2 Essentials editions do not support SQL Server and hence BillQuick 
2017 cannot run on those operating systems. 

 32-bit or 64-bit operating system (dual compatibility) 

 Microsoft .NET Framework 4.5 

 Be sure to install the latest Windows service packs and critical updates. Check the Microsoft website for 
the latest updates to Windows, .Net Framework, and Data Access Components. Some versions of Windows 
include an automatic update option. 

 

http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/ProductOverview.asp?prodId=WS
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Other System Requirements 
 

 Microsoft .NET Framework 4.5 or later (automatically installed with BillQuick)  

 Microsoft SQL Server 2008 or later (for BillQuick Enterprise edition)  

  Microsoft Data Access Components 2.8 or later (automatically installed with BillQuick) 

 Microsoft Windows Installer 3.0 or later (typically installed or updated with Windows) 

 Microsoft Internet Explorer 9 or later (for accessing BillQuick Online) 

 An Internet connection with a 256 KBps or faster modem, DSL, cable modem or other broadband 
connection (for accessing BillQuick Online and for Automatic Updates) 

 

INSTALLATION 
A ‘BillQuick Supervisor’ is responsible for planning and implementing the initial setup and deployment of 
BillQuick. To install BillQuick, you should be logged in as an administrator. Basic start-up procedures for 
BillQuick are: 

 Install BillQuick. 

 Create a BillQuick database.  

 Activate and license BillQuick. 

 Before installing the software, please read the End User License Agreement (EULA). 

You can see the basic steps in the flowchart below. 

 
 
 
 
 
 

http://www.bqe.com/
mailto:info@bqe.com
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Installing on a Computer System 

BillQuick can be installed on a single-user system or a network environment. BillQuick operates in a network 
environment, both peer-to-peer networks and networks with servers. In either scenario, the BillQuick 
database will be located in a folder on a personal computer or shared drive.  

Follow the steps below to install BillQuick on a personal computer. 

 Download a copy of BillQuick from http://www.bqe.com/products/billquick/downloads. Save the 
file on your local machine where you can access it easily, preferably your desktop. Unzip the 
contents of the file to your desktop. 

 The downloaded copy of BillQuick is in a Zip format. You will need a Zip archiving or extraction 
program such as WinZip (from a shareware website or a software store). 

 Right-click on the setup icon on your desktop and click Open.  

 When the BillQuick installation screen appears, read the information and follow the instructions on 
each screen by clicking Next.  

 

 

http://www.bqe.com/
mailto:info@bqe.com
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 Read the License Agreement and select the ‘I accept…’ option. Click Next.  

 Accept or modify the User Name and Organization. Click Next.  

 

 Choose a destination for BillQuick. Accept the default directory path by clicking Next. To change 
the path, click Change. 

 After the installation begins, a progress bar displays. When the Finished screen appears, click 
Finish.  

 When prompted, restart your computer to complete the installation. 

 Double-click on the BillQuick icon on your desktop to start the program. 

 Previous users of BillQuick will be prompted to upgrade the database. Click Yes to upgrade. First 
time users, click No and move to step 13. 

 BillQuick will now convert your previous database to BillQuick 2017. 

 After finishing, BillQuick will display the Welcome screen where you can choose to create a new 
database (Access or SQL) or select an existing one. See BillQuick Database for more. 

 New databases will be prompted with the BillQuick Startup Interview and then the Product 
Activation screen. 

http://www.bqe.com/
mailto:info@bqe.com
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Installing in a Network Environment 

In a network environment, you will add more users in BillQuick. We do not recommend installing the 
BillQuick program to a network drive. Only the database should be on the network drive. BillQuick needs to 
be installed on the computer of each person who needs to access it.  

To install BillQuick on a network environment: 

 Install BillQuick (see above). 

 Make sure the BillQuick database is in a shared folder. You can place your company database on a 
network directory or company server. Please make sure that all users have Read and Write access to 
that directory. 

 Start BillQuick.  

 Select File menu, Open Company and navigate to the shared folder.  

 Select your BillQuick database. BillQuick remembers the location each time you open it.  

 BillQuick also works in other network scenarios. Contact BillQuick Support for more information (310-
602-4030). 

 

Peer-to-Peer Network Environment 

To install BillQuick on a peer-to-peer network:  

 On the computer used by your primary BillQuick user (BillQuick Supervisor), complete the steps for 
installing BillQuick (as mentioned above), creating a database (see BillQuick Database), and 
activating BillQuick (see Product Activation below).  

 Start BillQuick.  

 Select File menu, Open Company and navigate to the shared folder.  

 Select your BillQuick database. BillQuick remembers the location each time the user opens 
BillQuick.  

Network Server Environment 

To install BillQuick in a network server environment, you can: 

 Install BillQuick, point to the database, and register the computer (follow the same steps as for a 

http://www.bqe.com/
mailto:info@bqe.com


GETTING STARTED GUIDE:  
BillQuick  

BillQuick  |  Power Up Your Business 
(866) 945-1595  |  www.bqe.com  |  info@bqe.com 11 

 

 

peer-to-peer network above). 

 Utilize Active Directory Services on a domain network. With this capability, you can ‘push’ BillQuick 
to the workstations.  

For more information, see the BillQuick Knowledge Base article How to Install BillQuick on Workstations 
using Active Directory Services.  

 BillQuick installs as a separate program. You can upgrade from your current version of BillQuick or 
uninstall it. When upgrading, BillQuick database conversion makes a backup of your database prior to 
converting it. However, the personal settings and report mappings are not retained. 

Installing with Microsoft SQL Server Express or SQL Server Standard 

BillQuick installation does not require SQL Scripts or special items to create a SQL Server Standard or SQL 
Server Express database for your company. All logic is built into BillQuick. 

 Support for full SQL Server as a backend is available in the BillQuick Enterprise edition only. 

 Install and configure Microsoft SQL Server Express or SQL Server Standard before installing 
BillQuick. Specifically: 

 Make sure to enable TCP/IP and Named Pipes for the SQL instance to which you are 
connecting. 

 Make sure SQL browser is running. 

 If you receive a message with Error 5, it is possibly a network or firewall issue. Please check 
all firewalls (including Windows) and make sure to add either port 1433 or BillQuick as an 
exception. 

 You can check our Installation Guides for SQL Server 2008 or SQL Server 2012 for details. 

 Install BillQuick on the primary computer that is accessed by the Supervisor. (See above.) 

 Start BillQuick and go to File menu, New Company, SQL Server Database. 

 Enter the Server Name, User ID, Password and Database Name. Typically, the database name is 
similar to the company name.  

http://www.bqe.com/
mailto:info@bqe.com
http://kb.bqe.com/questions.php?questionid=237
http://kb.bqe.com/questions.php?questionid=237
http://www.bqe.com/media/PDF/BQ/2017/BillQuick-SQL-Server-2008-Express-Installation-Guide.pdf
http://www.bqe.com/media/PDF/BQ/2017/BillQuick-SQL-Server-2012-Express-Installation-Guide.pdf
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 Click OK to create the database. 

 If your Server Name and SQL Instance Name do not display, go to My Computer, right-click and select 
Properties. On the Computer Name tab, find the Full Computer Name. In the Server Name field here, enter 
that name, backslash, and the instance name (default is ‘SQLEXPRESS’). 

 If you receive error messages or have any other trouble connecting to the SQL Server during BillQuick 
installation, please look up our Knowledge Base for related issues. Else, contact our Technical Support at 
(310)602-4030.  

Installing an Upgrade 

An upgrade contains significantly more new features, new reports, new functionality, and perhaps new user 
interface elements. When upgrading from one version of BillQuick to another, it does not retain your 
personal settings and report mappings. Upon starting, you will be asked to locate your database.  

If you have been using a MSDE or SQL Server database, BillQuick will create a newly converted database, 
with the same name as the existing one, but with ‘2017' added on at the end. It will leave the previous 
database as a backup in the pre-2017 format. In the case of Microsoft Access database, BillQuick will 
automatically make a copy of your database that is compatible with your current version. In addition to your 
main database, BillQuick will upgrade your archive file.  

http://www.bqe.com/
mailto:info@bqe.com
http://kb.bqe.com/
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 Please check the Upgrade to BillQuick 2017 whitepaper for details. 

 

START-UP 
In order to start BillQuick and create a company file, please follow the steps below. At this point BillQuick 
should already be installed on your computer. 

Setting up BillQuick Database 

For previous users, BillQuick will automatically open the last used database. First time users you will receive 
a prompt to select a company file and database type. In order to create a BillQuick database you will need 
system administrative privileges. Typically, a BillQuick Supervisor (or an IT administrator) handles this task 
and then informs the other users about its location, User ID and Password (if applicable). 

You can create a new company file in either a Standard database (Microsoft Access) or an SQL database 
(Microsoft SQL Server Express or SQL Server Standard). Your options depend on the edition of BillQuick you 
purchase: Basic, Pro or Enterprise. For trial version users, you have BillQuick Enterprise Edition by default. 
For evaluation purposes, most users choose the Standard option. After you purchase BillQuick and ‘go live’ 
a Standard database can be converted to a SQL database with only a click. 

 Click on the ‘Create a New Company File’ option (make sure the radio button is on Use Standard 
Database).  

 

http://www.bqe.com/
mailto:info@bqe.com
http://bqesoftware.net/media/PDF/BQ/2017/Upgrade-to-BillQuick-2017.pdf
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 Navigate to the folder where you want to store your company database. If you are in a network 
environment, this should be a shared folder. Place this file in a safe location such as My Documents 
or Program Files\BillQuick2017 folder. 

 

 Enter a name for the file (for example, your company name) and click Open. 

 You will receive a message confirming that your database was created successfully. Click OK and 
move on. 

Next, you will be prompted with the BillQuick Startup Interview wizard to provide basic information for your 
BillQuick company file. To do so, please follow these steps: 

 Select your Business Type. Depending upon your selection, pre-defined activity codes will be 
loaded into your database. 

 

http://www.bqe.com/
mailto:info@bqe.com
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 Based on your business type, BillQuick adjusts its terminology and labels. You can accept those 
labels or choose your own Custom Labels from the drop-down list. 

 In the Company Name field, please enter your company name exactly as you would like it to appear 
on your invoices to be printed from BillQuick.  

 Step through the other options and complete it to the best of your ability using the Next button. 
Click Help to check out the explanations where needed.  

 You do not require License and Registration keys in order to complete the Interview. 

 Click Finish and then close. 

 All of the settings that you choose in the Start-Up Interview can be edited later. 

 The BillQuick Initial Setup Checklist wizard displays. You can walk through a few of the wizards to 
set up master information or click Close. We will cover each major type of master information later 
in the Guide. 

 

http://www.bqe.com/
mailto:info@bqe.com
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After you have successfully created your company database, you can activate and register your product. 

Activating Product  

The Product Activation screen displays when BillQuick is not activated or is in evaluation mode. The screen 
provides four options.  

 Activate Now – Enter a key to continue your free 15-day trial. 

 Activate Later – Continue your free 7-day period of review. 

 Ready to Buy – Go to www.BillQuick.com to subscribe and purchase the software license. 

 Already Purchased – Enter your license and registration keys to activate BillQuick.  

 

 

http://www.bqe.com/
mailto:info@bqe.com
http://www.billquick.com/
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Evaluating BillQuick 

If you are evaluating BillQuick, you may choose Activate Now or Activate Later. Click Activate Now to 
provide your details to BQE Software and obtain an evaluation key. Activate Later allows you to continue 
working with BillQuick during a 7-day free trial. After this period, you must obtain an evaluation key or 
subscribe to a full software license.  

 Please enter valid information in the screen. This is how BQE Software will contact you with your 
evaluation, license and registration keys. When all the information is entered, click Next to continue. 

 

 Within a few minutes, you will receive your 15-day evaluation key via email. Alternatively, you can 
generate an evaluation key via the web or by calling BQE Software at (310) 602-4020.  

 Enter this Evaluation Key in the space provided. Click Activate. 

 BillQuick will now open with a reminder message stating that you are using an evaluation copy and 
to continue beyond 15 days, you need to subscribe and purchase the software.  

While in evaluation mode, continue to use BillQuick. All of the information entered now will be saved and 

http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/userservice/GetEvalKey2016.asp
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made available after switching from evaluation to licensed mode. 

Licensing and Registering 

BQE Software provides various options for licensing and registering your copy of BillQuick. You can use the 
Product Activation, Company or Product Licensing and User Management screen in BillQuick to do so. The 
BillQuick Supervisor usually subscribes and registers the BillQuick software. 

Follow these steps to proceed: 

 When you are ready to purchase and license BillQuick, click ‘I Am Ready to Buy’ option on the 
Product Activation screen. Purchase your subscription from the BillQuick website or call BQE 
Software at (310) 602-4020 to speak with a BillQuick Account Rep.  

You will receive your license and registration keys via email at the email address that you provide. 

 After subscribing to a full software license, click ‘Already Purchased’ on the Product Activation 
screen. It asks for your company name, license and registration keys.  

 

 Using the email you received, enter or cut-and-paste the information. It should be the same as you 

http://www.bqe.com/
mailto:info@bqe.com
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see in the email (if you want to make a change, contact your BillQuick Account Rep.).  

 Click Register. BillQuick is now licensed for the subscribed period. 

 When you evaluate other modules in the BillQuick Family, you can run the evaluation software and 
licensed software together.  

Alternatively, you can do the same thing using the Company screen. To do so: 

 Select Company from the View menu.   

 Enter your company name on its General tab. It should be exactly as printed on the email you 
received. Click Save. 

 On the License tab, enter or cut-paste the License Key from the email.  

 

 Click Tools and select Validate License Key. 

 Click Save. It displays the Edition and Number of Licenses purchased by you.  

http://www.bqe.com/
mailto:info@bqe.com
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 Click Tools and select Register 
Software.   

 Enter or cut-paste the 
Registration Key from your email. 
Click OK.  

You have successfully subscribed and 
registered your BillQuick! 
 

 In a networked environment, the supervisor or IT administrator needs to repeat the same procedure 
on each computer. 

To license BillQuick using the Console: 

 Open the Product Licensing and User Management screen from the File menu.  

 Enter the License Key against the relevant product (BillQuick) on the Licenses tab.  

 

 Click Update to save the license information.  

 Move to the Users tab. You can grant employees and vendors access to BillQuick and other add-on 
modules by marking the check box in the appropriate column.  

Alternatively, you can select rows and use the shortcut menu or button panel to Assign or Un-Assign a user 
to the relevant programs. 

 Choose the desired Security profile for an employee or vendor from the list, for example, Full 
Access, Time and Expense Only, Billing Only and so on. If you prefer to select individual security 
permissions for employees or vendors, click Security to do so from the Security screen. 

 When you have finished, click Close. 

http://www.bqe.com/
mailto:info@bqe.com
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BILLQUICK BASICS 
After installing BillQuick, you need to have an understanding of the basic options and procedures related to 
login, navigation and other general features. This section focuses on the basics of the BillQuick 
environment:  

 Starting Up BillQuick 

 Logging into BillQuick 

 Navigating BillQuick 

Starting Up 

To start up BillQuick, do one of the following: 

 In Windows, click Start and select Programs from the menu. From the program list, choose BillQuick 
2017.  

 On your desktop, double click the BillQuick desktop icon . 

If you have previously worked with BillQuick on your computer, BillQuick will automatically open the 
database that you were in the last time you used the software. You can skip to Logging In below.  

When you start BillQuick for the first time, it prompts you with the BillQuick Startup Interview in order to set 
up your company file. After you have successfully created your company database and the security is turned 
on, you will be prompted for a login. 

Logging In 

When security is turned on, the Supervisor and other BillQuick Users – employees and vendors – are 
supposed to log into the program to access its functions and features. Only employees and vendors 
designated as BillQuick Users (in their profiles) can access the software. 

By default, the Employee ID (or Vendor ID) of a user is also its login user ID and password. If you change the 
Employee ID of a user, the User ID is also changed. You can change the login password as needed and 
make them case-sensitive (from Global Settings screen). 

BillQuick allows you to have a separate Employee ID and Login ID, thus letting you customize your login 
name. For example, a user ‘Curtis James’ may have an Employee ID ‘CJ’ and Login ID ‘Curtis’. The new 

Login ID supports Windows Authentication, allowing you to bypass the BillQuick Login screen completely. 

http://www.bqe.com/
mailto:info@bqe.com
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This ID can be set in the Employee or Vendor screen. 

You can choose between the following login options: 

 Logging into Standard Database 

 Logging into SQL Database 

Logging into Standard Database 

The BillQuick Login dialog box displays the company name and database location. To log into a BillQuick 
standard (Microsoft Access) database, note the following: 

 For the BillQuick Supervisor, the default User ID and Password is ‘supervisor’ (without quotes). 
Please change the Supervisor password before deploying BillQuick in your company. 

 

 Enter your User ID and Password provided by the Supervisor.  

 When only one person uses a particular computer, mark the Remember check box to make your 
User ID the default.  

 Check the Windows Authentication option if you want to bypass the BillQuick login in future. Your 
access to the BillQuick database is controlled by your Windows NT account or group, which is 
authenticated when you log on to the Windows operating system on your system (client machine). 

 Click OK to access BillQuick. 

Logging into SQL Database 

If you are using a SQL Server database, you have to log in with correct User ID, Password and other 
information. The SQL Server will not complete a connection unless it has verified your login ID.  

http://www.bqe.com/
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  Support for full SQL Server as a backend is available in the BillQuick Enterprise edition only. 

When BillQuick Enterprise creates or up-sizes a database on the SQL Server, it creates two logins:  

 BillQuickSQL with password ‘admin’ 

 BillQuickGuest with password ‘Guest’ 

 You can change the password of BillQuickSQL User using Global Settings from the Settings menu. 

BillQuick allows you to connect to the SQL Server via  

 Windows Authentication (Trusted Connection): establishes connection to the SQL Server using the 
Windows Logon credentials (that is, Windows User ID and Password). It does not need your login 
ID; or 

 SQL Server Authentication (Standard Security): establishes connection to the SQL Server using your 
assigned SQL Server login ID and password. 

 See BillQuick Help for more on SQL Login and Authentication. 

After logging in, the default or role-based navigator appears.  
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Navigating BillQuick 

Anyone familiar with Microsoft Windows and Microsoft Office will find BillQuick easy to use. Role-based and 
standard navigators, menu bar, sidebar, icon toolbars, action buttons, screen layouts, spreadsheet-like 
grids, shortcut keys, and other user interface elements look and feel like these programs.  

 Security permissions determine what features, functions, and information a user can view and access on 
the navigators, toolbars, menu bar and screens. BillQuick disables or grays out unavailable items. 

There are actually four ways to navigate and use the program: 

 Menu Bar 

 Toolbar 

 Sidebar 

 Navigators  

Menu Bar 

Like all Windows applications, BillQuick has a menu bar at the top, from where you can access the following 
menus: 

 

Toolbar 

The toolbar allows you to access BillQuick functions quickly. You can turn it on or off from the User 
Preferences screen or by right clicking on the menu bar. 

 

Sidebar 

On the left side of the BillQuick desktop, you can conveniently access major functions from the Sidebar. The 
bar is divided into four panels, grouping the common functions together under each. 
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Navigators 

BillQuick navigators let you easily understand the workflow and quickly access important features and 
modules of the program. BillQuick provides you with a default role-based navigator and five function-based 
navigators. You can choose to make any of them your default navigator.  

The function-based navigators include: Company, Business Management, Time and Expense Workflow, 
Billing and Accounting. You can choose a navigator from the Sidebar or from the corresponding menu. 

The role-based navigator is a customized navigator giving you easy access to the most often used functions 
according to your role. Since you have logged in as the Supervisor, it would display the Default navigator 
(home page). Other roles include: Time and Expense, Billing and Principal/Management. 

Main 

 Company navigator 

 Management navigator 

 Time & Expense 
navigator 

 Billing navigator 

 Accounting navigator 

 Client 

 Project 

 Dashboard 
 

Time and Expenses  

 Home (Time & Expense 
navigator) 

 Time Entry (Sheet View) 

 Calendar View 

 Timer 

 Expense Log 

Billing 

 Home (Billing 
navigator) 

 Billing Review 

 Manual Invoice 

 Invoice Review 

 Payments 

 
Wizards 

 BillQuick Interview 

 Employee 

 Client 

 Project 

 Phased Invoice 

 Activity 

 Expense 

 SFS 

 EFS 

 Invoice 
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You can find other easy options for navigation within various BillQuick screens. You can access related 
screens from the ‘View’ drop-down menu as in case of Sheet View, Expense Log, and so on. Alternatively, 
screens may contain links to other related screens; for example, you can directly access the Invoice Review 
screen from the Billing Review screen and Payment screen from the Invoice Review screen.  

Besides this, you can quickly switch between open screens by using Ctrl+Alt+Tab. BillQuick also supports 
various keyboard shortcuts. 

 

MASTER INFORMATION 
Master information is the foundation of any time and billing system. This section covers the basics of master 
information maintained in BillQuick.  
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 Basic master information can be set up using BillQuick wizards via the View menu, Wizards. Blue field 
labels on the screens indicate required information. 

Entering Company Information 

The Company screen contains a profile of your company. Information on this screen appears on reports and 
invoices. It also affects how BillQuick processes your company’s information. 

 When you close the BillQuick Initial Setup Checklist wizard, the Company screen automatically 
opens (if it does not, click View menu, Company). 
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 On the General tab, enter your company name, address and all other relevant contact information 
in the appropriate fields. 

 When finished, click Save and then Close. 

Your company information is now saved in the database. Let us create an employee profile. 

Entering Employee Information 

Employee screen represents a profile of a person working in a company on various projects. This screen 
allows you to add and maintain employee-related data, including tax, allowance, performance, and so on. 
Employee information prints on reports and invoices.  

To create an employee profile: 

 Open the Employee screen from the Company navigator or View menu. 

 If this is your first employee, the pointer will default to the Employee ID field. If other employees 
exist in your company database, click New on the button bar. This places the pointer in the 
Employee ID field and you are ready to create a new employee profile.  
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 Enter the Employee ID. You can use numbers, letters or a combination of both, up to 65 characters. 
For example, if the name of the employee is Curtis James, you may enter CJ as his ID. 

 Enter all relevant and required data. Press the Tab key to move from field to field or click on the 
next field.  

 Now, click the Rate tab. Enter the default Bill Rate and Cost Rate (Pay Rate x Overhead Multiplier) for 
the employee. For example, enter $100 as the Bill Rate, $40 as the Pay Rate and 2 as the OM. 

 When you have finished, click Save and then Close. 

 Similarly, you can create a vendor/consultant profile in the Vendor screen (View menu). 

Entering Client Information 

The Client screen contains company name, address, and other client information, plus you can maintain an 
unlimited number of contacts per client. In addition, you can set billing options, view summary account 
information and transaction history of a client from here.  

To create a client profile: 

1. Open the Client screen from the Company navigator or View menu. 
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 If this is your first client, the pointer is automatically placed in the Client ID field. Otherwise, click 
New to create a new client record.  

 Select easy to remember letters or numbers as the ID for the client. For example, BQES for BQE 
Software. 

 Many users make the Client ID similar to the Company name. Rather than numbers or a cryptic 
abbreviation, they use more of the 65 available characters for the ID. For example, rather than AT or 4555 
for the Client ID, the ID would be Allied Tech. 

 Enter all relevant and required data. Press the Tab key to move from field to field or click on the 
next field.  

 When you have finished, click Save and then Close.  

Entering Project Information 

Using the Project screen, you can create and maintain a profile for each project that you work on. Project 
information affects how data and billing is processed and done and how it flows to various reports and 
invoices. 

To create a project: 

 Open the Project screen from the Company navigator or Project menu. 

 If this is your first project, the pointer is placed in the Code field automatically. Otherwise, click New 
to create a new project record. 

 Enter a Code for the project. If necessary, you can break down this project into phases, though 
Phase is not a required field. When you save the project, BillQuick automatically combines the 
Project Code and Phase fields into a single Project ID. 

 An expanding best practice is to utilize the 65-character length of the Project ID field to make it easier 
and faster for users to recognize what the project is for and for whom the project is being done. The best 
practice is to repeat the Client ID as part of the Project Code.  

 Enter other required data: Name, Client, Manager, Status, and Contract Type.  

 Under Contract Type, select the right type of contract or billing arrangement (hourly, fixed, cost 
plus, and so on). If a lump sum contract is selected, be sure to fill in the Contract Amount.  
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 Enter all relevant data. Press the Tab key to move from field to field or click on the next field. 

 When you have finished, click Save and then Close. 

Entering Activity Codes 

On the Activity Codes screen, you can create and maintain a list of standard activities performed by 
employees (or vendors) on projects. Depending on your industry and company preferences, you can 
choose a standard list of activity codes. Activity information flows to the invoices and reports.  

To create an activity code: 

 Open the Activity Codes screen from the Company navigator or View menu. 
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 To add a new activity, click New.  

 Type the desired Code and, optionally, Sub (code) in the grid.  

 Make sure that each billable activity has a check in the Billable column and non-billable items are 
left unchecked.  

 Enter all relevant and required data. Press the Tab key to move from field to field or click on the 
next field. 

 If you charge taxes for your services, use the Field Chooser  to show the Tax 1/2/3 fields by marking 
those check boxes. 

 To save an activity record, click on another row or press the Tab key through the end of the row. 

 When you have finished, click Close. 

 BillQuick automatically adds GEN:HOL, GEN:SICK and GEN:VAC activity codes to your database. 
Activity Codes for these special items can be customized in the Global Settings screen. Similarly, you can 
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create expense items in the Expense Codes screen. 

 

TIME AND BILLING 
This section focuses on time entry and billing capabilities of BillQuick. It helps you to understand the basics 
of how to enter, edit and review time entries, and how to bill them effectively. This section covers the 
following: 

 Time Entry 

 Billing Review 

 Invoice Review 

 Payments 

Entering Time 

There are four time entry options in BillQuick:  

 Sheet View 

 Simple Time Card 

 Calendar View  

 Timer 

All time entries are saved in the same database. You can edit and review entries on the Sheet View, Simple 
Time Card and Calendar View screens. 

To record a time entry using the Simple Time Card: 

 Open the Simple Time Card screen from the navigator or Time-Expense menu. 

 Select the View By: Employee mode. The Simple Time Card allows you to view time entry by 
Employee or Vendor. 

 In the Employee field, select the desired employee from the drop-down list. 

 Next, select the Period Including date for which you want to record or review hours. If any time was 
recorded during that week, it displays automatically.  

 Select the desired Project ID from the drop-down list. BillQuick also supports selecting projects by 
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name. 

 Select an Activity ID from the drop-down list. The Description for the activity automatically displays.  

 Whether a time entry is billable or not depends on the default value that you assign to the activity in the 
Activity Codes screen (see Activity Codes above).  

 In the appropriate cell (under the desired day or date of the week), enter the hours worked on a 
specific activity-project combination. Use decimals if needed. 

 

 To add a memo, press Ctrl+M or click  to open it at the bottom of the screen. Enter as much text 
as you want; then press Ctrl+M to return to the grid. A corner tag appears in the grid cell as a visual 
indicator. You can spell-check, edit or date-time stamp your time memo, if desired.  

 Depending on the invoice format chosen, a time entry memo can appear on your invoices. Memos also 
print on various reports. 

 When you have finished, click Save and then Close. 

Similarly, you can record expense entries in the Expense Log or Simple Expense Log screen.  
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BILLING 
BillQuick allows you to generate invoices by client, project, manager, contract type and by whatever billing 
period you wish. You can display as much or as little detail as you want on your invoices when you print or 
email them to your clients. 

To generate an invoice: 

 Open the Billing Review screen from the Billing navigator or Billing menu. 

 Using the ‘View by’ drop-down, select Project. You can also select other options. 

 

 Using the Project From-To fields, select relevant projects to bill from the drop-down list. 

 In the Period field, select your billing period (for example, if you bill by month, select This Month). 
You can also specify any Custom date range.  

 After setting the filters, click Refresh. BillQuick displays all billing records that meet your criteria. 

 Review all entries before continuing. To drill down to individual time and expense entries for a 
billing record, select the row and click Details in the button bar. From the list, select Time Details or 
Expense Details as needed. 

 If desired, adjust the Net Bill amount by applying a discount, retainer on account, or writing up or 
down individual time entries. Else, adjust the Net Bill amount manually to any value you want. 
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 Net Bill is the amount to be billed to the client. Depending on the contract type of the project, the Net 
Bill amount may be the total value of time and expenses charged to a project, a fixed fee amount, a 
scheduled bill amount, a recurring amount or a percent complete computation. 

 To process a billing record into an invoice, check the Bill option in the row. If desired, you can 
‘batch bill’ multiple records at one time. Select the rows to bill and then click Bill Sel.  

 Finally, click Process and select Process Final from the list. If you want to produce a draft invoice, 
select the ‘Process as Draft’ option. The selected billing records disappear and move to the Invoice 
Review screen.  

 When you have finished, click Close. 

Now you are ready to review and print your invoices before sending them to your clients. 

Reviewing Invoices 

From the Invoice Review screen, you can review and finalize invoices, including draft and late fee invoices. 
All billing records processed from the Billing Review and Manual Invoice screens display here and can be 
printed or emailed to the clients.  

To review and print your invoice: 

 Open the Invoice Review screen from the Billing navigator or Billing menu. 
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 The top panel of the screen contains Filters and More Filters section, letting you specify filters for 
selective viewing of invoices. For now, uncheck all filters and click Refresh to display all invoices (if 
you created a draft invoice, check the Draft check box and click Refresh). 

 Select an invoice on the grid and review it. Click Print to produce a hard copy of the invoice. You 
can also Post, Email or Preview it. 

 When you have finished, click Close. 

Recording Payments 

On the Payment screen, you can record payment amount received from clients. These payments can be 
applied to invoices or recorded as retainers (funds on account or advance). When recording payments, you 
can distribute the amount over multiple invoices.   

To apply a payment: 

 Open the Payment screen from the Billing navigator or Billing menu. 

 Select the View by: Client option and choose the desired Client ID.  

 

 Select a Project ID (optional), Date and Pay Method to be used for recording payments.  
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 Enter the total payment in the Amount field.  

 Now decide which invoices should receive the payment. To automatically apply the payment 
amount (oldest to newest invoice), check the Auto Apply option. To apply the payment manually to 
individual invoices, check the Apply option in the grid.  

 BillQuick automatically updates the Balance due for the listed invoices as you apply the payment. 
When you have finished, click Save. 

 BillQuick prompts you to save any unapplied amount as a retainer. Click Close. 

 

REPORTS 
Reports contain information to help you understand what exists in 
your company database, what is due to you, the status of work 
being performed, utilization of resources, unbilled and billed 
work, and much more. They compile and present recorded and 
processed information. BillQuick includes more than 500 reports 
and 180 invoice templates, each with filter options that allow you 
to review precisely the information you need.  

BQE Software develops all reports using Crystal Reports, the most 
widely used report writer software. In addition, all your reports and 
invoice formats can be customized by the BQE Reports Team. 

Reporting 

BillQuick reports can be produced by selecting one from the 
Reports menu, Report Center or any BillQuick screen (in-context 
reports).  

To view or print a report:  

 Select a report from the Reports menu. For example, 
Analysis, Gross Margins.  

 From the Report Filters screen, apply filters to view specific data (by dates, clients or projects). 

 After you have applied the desired filters, click Preview or Print.  

 Alternatively,  
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 Open the Reports menu and choose Report Center.  

 Under Report List, click  to open a category of reports and select the desired one. You can see its 
preview on the More tab. 

 On the Filters tab, you can apply Date, Other and Group Filters by selecting items from the drop-
down lists. 

 

 Click Print or Preview to view the report.  

 When you have finished, click Close. 

 BillQuick comes with several sample databases. Select one from the File menu, Open Sample 
Company. Use it to preview reports to better understand the information within each. 

 
 
Congratulations! You have now successfully installed BillQuick and understood its basic functionality. If you 
have any troubleshooting or technical issues while installing or setting up the software, please visit our 
Knowledge Base.  

To learn more about this program, check the BillQuick Help or visit the BillQuick website. For more 
information, visit us at www.bqe.com.If you have any trouble using BillQuick, please contact BillQuick 
Support at (310) 602-4030 orSupport@bqe.com. For other questions, please call us at (888) 245-5669 (US 
and Canada) or (310) 602-4020; or email Sales@bqe.com.

http://www.bqe.com/
mailto:info@bqe.com
http://kb.bqe.com/
http://www.bqe.com/products/billquick
http://www.bqe.com/
mailto:Support@bqe.com
mailto:Sales@bqe.com


 

 

World Headquarters 
For more information, visit 
www.bqe.com or call 
(866) 945-1595. 

North & South America 
3825 Del Amo Boulevard, Torrance, CA 90503 
United States of America 

Tel: (866) 945-1595 (toll-free) 
+1 (310) 602-4010 

www.bqe.com 
www.twitter.com/BillQuick 
www.facebook.com/BillQuick 

Email:   sales@bqe.com 
support@bqe.com 

Europe, Middle East & Africa 

©2006-2017 BQE Software Inc. All rights 
reserved. BQE, BQE logo and BillQuick logo 
are registered trademarks and/or registered 
service marks of BQE Software Inc. in the 
United States and other countries. Other 
parties’ trademarks or service marks are the 
property of their respective owners. Regional Offices 

Australia, New Zealand & Asia 
Level 40 North Point Towers, 100 Miller Street, North Sydney, NSW 2060 
Australia 

Tel:  +442033188111 

Email:   uk-sales@bqe.com 
uk-support@bqe.com 

Tel: 1300 245 566 (toll-free) 
+61 (02) 9657 1355 

Email:   aus-sales@bqe.com 
aus-support@bqe.com 

BillQuick  |  Power Up Your Business 
(866) 945-1595  |  www.bqe.com  |  info@bqe.com 

 

 

http://www.bqe.com/
http://www.bqe.com/
http://www.twitter.com/BillQuick
http://www.facebook.com/BillQuick
mailto:sales@bqe.com
mailto:support@bqe.com
mailto:support@bqe.com
mailto:uk-sales@bqe.com
mailto:uk-sales@bqe.com
mailto:uk-support@bqe.com
mailto:uk-support@bqe.com
mailto:aus-sales@bqe.com
mailto:aus-support@bqe.com
mailto:aus-support@bqe.com
http://www.bqe.com/
mailto:info@bqe.com

	CONTENTS
	INTRODUCTION
	BillQuick Setup Checklist

	SYSTEM REQUIREMENTS
	Hardware Requirements
	Software Requirements

	INSTALLATION
	Installing on a Computer System
	Installing in a Network Environment
	Peer-to-Peer Network Environment
	Network Server Environment
	Installing with Microsoft SQL Server Express or SQL Server Standard
	Installing an Upgrade

	START-UP
	Setting up BillQuick Database
	Activating Product
	Evaluating BillQuick
	Licensing and Registering

	BILLQUICK BASICS
	Starting Up
	Logging In
	Navigating BillQuick

	MASTER INFORMATION
	Entering Company Information
	Entering Employee Information
	Entering Client Information
	Entering Project Information
	Entering Activity Codes

	TIME AND BILLING
	Entering Time

	BILLING
	Reviewing Invoices
	Recording Payments

	REPORTS
	Reporting


